# AutoCAD Skills You’ll Need to Use Civil 3D

## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assumptions I’ve Made About the Learner</td>
<td>3</td>
</tr>
<tr>
<td>Microstation Lingo vs AutoCAD Lingo</td>
<td>4</td>
</tr>
<tr>
<td>Things that exist in AutoCAD, but not Microstation</td>
<td>4</td>
</tr>
<tr>
<td>Things that exist in Microstation, but not AutoCAD</td>
<td>4</td>
</tr>
<tr>
<td>General Interface Stuff</td>
<td>5</td>
</tr>
<tr>
<td>Ribbons</td>
<td>5</td>
</tr>
<tr>
<td>The Command Line</td>
<td>8</td>
</tr>
<tr>
<td>Panning and Zooming</td>
<td>8</td>
</tr>
<tr>
<td>Selecting Things</td>
<td>9</td>
</tr>
<tr>
<td>Just a Click</td>
<td>9</td>
</tr>
<tr>
<td>Window Selection</td>
<td>9</td>
</tr>
<tr>
<td>Cycle for Selection</td>
<td>10</td>
</tr>
<tr>
<td>Selecting, and then Right-clicking</td>
<td>11</td>
</tr>
<tr>
<td>Display Order</td>
<td>11</td>
</tr>
<tr>
<td>Properties</td>
<td>12</td>
</tr>
<tr>
<td>Drawing Lines, Polylines and 3D polylines</td>
<td>14</td>
</tr>
<tr>
<td>Lines</td>
<td>14</td>
</tr>
<tr>
<td>Polylines</td>
<td>15</td>
</tr>
<tr>
<td>3D Polylines</td>
<td>16</td>
</tr>
<tr>
<td>Other general tidbits about lines</td>
<td>17</td>
</tr>
<tr>
<td>Working with Layers</td>
<td>18</td>
</tr>
<tr>
<td>Creating a New Layer</td>
<td>18</td>
</tr>
<tr>
<td>Layer Properties You Will See</td>
<td>19</td>
</tr>
<tr>
<td>Don’t Freak Out – Use Layer States</td>
<td>20</td>
</tr>
<tr>
<td>Other Layer Tidbits</td>
<td>20</td>
</tr>
<tr>
<td>Using Object Snaps</td>
<td>21</td>
</tr>
<tr>
<td>Basic Modify Tools</td>
<td>22</td>
</tr>
<tr>
<td>Erase</td>
<td>22</td>
</tr>
<tr>
<td>Move</td>
<td>23</td>
</tr>
<tr>
<td>Copy</td>
<td>24</td>
</tr>
<tr>
<td>Offset</td>
<td>24</td>
</tr>
<tr>
<td>Rotate</td>
<td>25</td>
</tr>
<tr>
<td>Explode</td>
<td>25</td>
</tr>
</tbody>
</table>
Block Basics ............................................................................................................................................... 27
  Inserting from a Toolpalette .................................................................................................................. 28
  Inserting a Block Using the Insert Command ........................................................................................ 29
    Existing Block .................................................................................................................................... 29
    Browsing for Blocks ........................................................................................................................... 29
    What About Those Settings? .............................................................................................................. 30
Paperspace and Modelspace ......................................................................................................................... 31
  The Model Tab (the “Real” Modelspace) .............................................................................................. 31
  Layout – Paperspace ............................................................................................................................... 31
  Layout- Modelspace ............................................................................................................................... 32
Bare-Bones Printing ................................................................................................................................... 33
  Getting Ready to Print ............................................................................................................................ 33
  The Print ................................................................................................................................................. 35
External References (XREFs) ....................................................................................................................... 37
Next Steps ................................................................................................................................................... 38
Assumptions I’ve Made About the Learner

If you are reading this there are probably a few things that are true:

- You are a go-getter who wishes to educate himself/herself about AutoCAD
- You have a decent sense of humor about technology.
- You are open to learning about new stuff.
- You are getting ready to learn Civil 3D 2010.

There are some other things I’ve assumed about you too. Want to hear them?

- You have a mouse with a scroll wheel.
- You have a decent knowledge of Windows.
  - You know how to browse for files.
  - You know what a save icon looks like.
  - You know what an undo icon looks like.
- You have used Microsoft Word or a similar word processing program.
- You are teaching yourself AutoCAD from within the Civil 3D 2010 interface.
- You have a Microstation, BricsCAD or previous version AutoCAD background.
Microstation Lingo vs AutoCAD Lingo

<table>
<thead>
<tr>
<th>Microstation</th>
<th>AutoCAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smartline</td>
<td>Polyline</td>
</tr>
<tr>
<td>Line</td>
<td>Line</td>
</tr>
<tr>
<td>Level</td>
<td>Layer</td>
</tr>
<tr>
<td>Cell</td>
<td>Block</td>
</tr>
<tr>
<td>Element</td>
<td>Object</td>
</tr>
<tr>
<td>Dimension</td>
<td>Dimension</td>
</tr>
<tr>
<td>Block</td>
<td>Rectangle polyline</td>
</tr>
<tr>
<td>Handle</td>
<td>Grip</td>
</tr>
<tr>
<td>Drop element</td>
<td>Explode</td>
</tr>
<tr>
<td>Update View</td>
<td>Regen</td>
</tr>
<tr>
<td>Element Priority</td>
<td>Draw order</td>
</tr>
<tr>
<td>Pen Tables</td>
<td>Plot Styles</td>
</tr>
<tr>
<td>View</td>
<td>Modelspace Viewport</td>
</tr>
<tr>
<td>Configuration file</td>
<td>Options</td>
</tr>
<tr>
<td>Element attributes</td>
<td>Properties</td>
</tr>
<tr>
<td>Fit View</td>
<td>Zoom Extents</td>
</tr>
<tr>
<td>Patterning</td>
<td>Hatching</td>
</tr>
<tr>
<td>AccuDraw</td>
<td>Polar tracking</td>
</tr>
</tbody>
</table>

Things that exist in AutoCAD, but not Microstation

- A Save button. AutoCAD behaves more like other Windows programs with its save functionality.
- Paperspace and modelspace. Microstation uses the concept of “sheet models” to do what AutoCAD does in layout mode.
- Polar tracking at specific angles.
- Undo for multiple actions.

Things that exist in Microstation, but not AutoCAD

- Groups are an item that doesn’t exactly exist in AutoCAD. In AutoCAD you can use a block, or you could put items you want to work together on the same layer.
- Stream line string.
- View attributes from Microstation would be equivalent to a mix of options from the Options dialog box and settings found on the status bar of AutoCAD.
- Multiple views – some on other screens.
- Really fancy line types.
General Interface Stuff

When you open up Civil 3D 2010, you will see a plethora of buttons, tools and icons.

The tools that you will use in the course of reading this document are:

- The drawing area
- Command line
- Ribbon tabs
- Ribbon panels
- Toolpalettes
- Model and Layout Tabs
- Application Menu

Ribbons

The ribbon interface is probably new to you.

The tabs across the top, (Home, Insert, Annotate, Modify, Analyze, View, Output, Manage, and Express Tools) represent different categories of tools. Each tab gives you a logical grouping of tools.

The only two tabs we will be visiting in this document are Home and Insert.

When a tab is active, you will see the tools split into more specific categories in panels. Panels bring specific types of commands together.

For example, let’s look at the Draw Panel.

At the top of the panel are the more common tools. This panel can be expanded, as indicated by the black dropdown arrow.

Click the black arrow to expand the panel. We see quite a few more tools.

Click the thumbtack icon in the lower left of the panel to keep the expanded view.
You may notice that some of the buttons are split into a command and a dropdown.

The dropdown button gives you multiple ways to execute a command. In the example shown here, there are multiple ways to determine the size and location of a circle.
The Command Line

The AutoCAD command line is how you and AutoCAD can talk to each other. AutoCAD will tell you what type of information it is expecting, and you tell AutoCAD the value or option you want.

When you see **Command:** in the command line, you know that AutoCAD is not busy, and waiting for you to give it your next instructions.

Every tool that you use has a key-in version as well as an icon on the ribbon. For instance, you can click the polyline icon or type **PL** at the command line, then hit enter.

Panning and Zooming

Most of your panning and zooming will be done with your mouse’s wheel.

- ★ Roll the wheel forward to zoom in to an object.
- ★ Roll the wheel towards you to zoom out.

For zooming with the wheel, the location of your cursor is where AutoCAD centers the screen.

- ★ Press and hold the middle mouse wheel to pan the screen.
- ★ Double-click the middle mouse wheel to zoom extents.
Selecting Things

It may sound simple, but knowing how to select objects efficiently in AutoCAD will make using Civil 3D much easier.

★ The first thing you need to know is that if you are not actively in a command, AutoCAD is in a selection mode.

After you are done with a command, the tool you are using is no longer active and you are back at a Command: prompt in the AutoCAD command line.

This is very different for users who may be used to software that keeps you in a command until you switch tools (such as Microstation or Photoshop).

All of the techniques discussed in this section will work outside of a command or at the Select Objects: prompt when you start working with commands.

Just a Click

When you are not in a command, and you click on an object, you will see blue squares at key points. These blue squares are called grips.

★ If you click a grip, you can move or adjust the object.

★ If you are in a command, such as move, you will not see grips but you will see objects become dashed.

Window Selection

To select multiple items at once, use a selection window. Click on the screen where you have no CAD objects and a selection window is started. Drag across your screen and you will see a temporary rectangle forming.

★ The direction that you drag your selection window makes a difference!

Dragging left to right across your screen will give you a blue field with a solid line around it.

Only objects that are completely inside the blue area will become selected.

Items that are partially in, but cross the solid line are not selected.
Dragging right to left across your screen will give you a green field with a dashed line around it.

Objects inside the green area and anything touching the dashed line will become selected.

Items that are partially inside will also become selected.

**Cycle for Selection**

In Civil 3D you will find that you have many objects that share the same location. For example, a flange line will coincide with a line representing edge of asphalt. Knowing how to quickly select items that are “hiding” behind other objects will increase your productivity greatly.

The following illustration shows three objects that partially overlap. Notice that different objects appear to “light up” as the cursor hovers over.

Items that are drawn first tend to get covered up by items that are drawn after them. In AutoCAD this is called *Display Order*. We will discuss display order later in this section.

If you wish to select an object that is under another object, you can use **Shift+spacebar** to force the underlying object to rise to the top for selection. To cycle through the objects that may be under your cursor, keep holding shift key while hitting the spacebar.

You need a steady mouse hand, but when the object you are after appears to light up, click it.

You may even discover an object you didn’t realize as there!
Selecting, and then Right-clicking

It is important to get comfortable with using the right-click button on your mouse; in Civil 3D, right-clicking is HUGE!

★ Outside of a command, if you have an item or group of items selected, right-clicking will give you a list of options that are specific to the item(s).

A very handy tool to know is the Select Similar command.

Select similar will look for objects of the same type on the same layer, and select them all in one shot.

Display Order

If you draw something in AutoCAD, and then draw another thing on top of the first thing, the second thing will obscure the first thing where they overlap.

HUH?

Regardless of actual elevation, objects drawn on top of each other (i.e. they share the same XY space) will take precedence over the items drawn before them. For instance, if cycle for selection isn’t working, use the Display order commands to get to the objects you want.

Select the object you wish to work with. Right-click and select display order.

- Bring to Front – takes the selected object and puts it in front of other objects that intersect it.
- Send to Back – pushes the selected object behind all the others that it intersects.
- Bring Above Object – moves the selected entity on top an object you select.
- Send under Object – moves the selected entity behind the object you select.

★ Display order has no effect on actual elevation. It’s just a graphics thing.
Properties

The properties tool palette is a great tool to know. The properties palette allows you to see information about a selected object and make modifications.

From the previous section, you know that selecting an object, and then right-clicking it is a way to view commands associated with an object. Properties is one of the items you can access this way.

You can also access the properties palette by clicking the Properties icon from the palettes panel on the Home tab.

At the top of the properties palette, you will see the type of object you have selected.

You can change many things about an object right from here, such as the layer and elevation.

If you have multiple objects selected, you will see the number of items in parenthesis at the top of the properties panel.

Click on the dropdown to see the breakdown of the types of objects.
If you wish to make changes using the properties palette, you will need to click into the area you want to change to “wake up” the cell.

In the example shown at left, clicking on the color property exposes a dropdown menu where the color can be changed.

Any properties that cannot be changed here will appear slightly grayed out.
Drawing Lines, Polylines and 3D polylines

The differences between lines, polylines and 3D polylines are significant to the Civil 3D world.

All of these commands are located on the Home tab > Draw panel

Lines

An AutoCAD line is any two points in space, just like you learned in grade school. 

A line can have differing elevations at each end. The differing elevations may be a result of snapping to nodes of different elevation.

Be aware that a chain of single lines will not join if they have a Delta Z value other than 0.

Also, if you convert a line to a polyline, check the resulting polyline elevation. The result may be totally unexpected!
**Polylines**

The term Polyline refers to a 2D polyline. A 2D polyline is a chain of line segments and/or arcs at the same elevation.

A polyline can be at an elevation, but every vertex is at the *same elevation*.

When you start the polyline command, if you happen to snap to something at an elevation, the rest of your line will all be at the same elevation.
3D Polyline

A 3D polyline is also a chain of line segments, but it cannot contain arcs. Each vertex of a 3D polyline can be at different elevations.

You can edit each vertex independently through the properties if you wish.

Notice how the screen shot at left shows that we are sitting on vertex 7.

You’ll also see the 7th vertex from the left has an X glyph on it, showing us graphically what we are editing.

When you get into Feature Lines in Civil 3D, there are much slicker ways to set elevations.

<table>
<thead>
<tr>
<th>Civil 3D Function</th>
<th>Line</th>
<th>Polyline</th>
<th>3D Polyline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert to Alignment</td>
<td>Yes  (Civil 3D 2010 +)</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Convert to Feature Line</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Convert to Pipe Network</td>
<td>Yes</td>
<td>Yes, but…*</td>
<td>Yes</td>
</tr>
<tr>
<td>Add to Surface as Breakline</td>
<td>Yes</td>
<td>Yes, but…*</td>
<td>Yes</td>
</tr>
<tr>
<td>Add to Surface as Contour</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Convert to Profile</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

*Watch your elevations! Remember all vertex elevations are the same for a polyline.
Other general tidbits about lines:

- Splines are evil. 😞 Do not use these! You may receive a drawing from someone who thought splines looked pretty when they drew contours in base AutoCAD. In this situation use SPLINEDIT command 📊 to convert splines to polylines.

- If you have individual line segments and wish to convert them to a polyline use the PEDIT command 📊.
  
  o Start the PEDIT command.
  o Type M for Multiple.
  o When you are prompted to convert objects to polylines, hit enter for yes.
  o Type J for join. (Then enter)
  o If all of the segments are touching, you can use a fuzz distance of 0. If there are gaps between the lines, type a fuzz distance that will force the lines to close. (Hit enter)
  o The command line will report how many segments were joined. If fewer segments were joined than you expected – there are two possible causes:
    1. The lines are at differing elevations. (Use the FLATTEN command to fix)
    2. The fuzz distance is not large enough to close the gaps.

- If you have objects that you wish to “smoosh” down to zero elevation, use the FLATTEN command. FLATTEN pushes 3D polylines, polylines and lines down to elevation 0. When asked if you’d like to remove hidden lines, Yes will convert the object to a 2D polyline, and will remove any vertices that are not visible in plan view. If you don’t wish to change the object type, use NO when asked to remove hidden lines.
Working with Layers

Everything you draw should go on a layer. No exceptions! The good news is that once you get Civil 3D involved, it will “push” things to the correct layer.

Layers are key to AutoCAD in keeping your drawing well organized. They are especially valuable when it comes to printing because you can freeze items you don’t wish to display on a plot.

When you start a drawing tool and start drawing, that line is being created on the current layer. You can tell what layer is current by looking at the layer dropdown on the Home tab > layer panel.

To switch which layer is current, make sure nothing is selected in the drawing and click on the dropdown arrow and select the layer you want.

Creating a New Layer

To create a new layer:
1. Click the Layer Properties Manager Button.
2. Inside layer properties manager, click the new layer button.
3. Type in the layer’s name and hit enter to continue.
4. You may wish to make the new layer current by double clicking on it in the layer manager.
Layer Properties manager can be closed or kept open like any other Tool Palette. (See Working with Tool Palettes for more information)

Layer Properties You Will See

Note: Modelspace and viewport concepts are discussed in depth in the next section.

<table>
<thead>
<tr>
<th>Icon</th>
<th>What it does:</th>
<th>Additional Info:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Layer is thawed in main modelspace" /></td>
<td>Layer is thawed in main modelspace</td>
<td>Use the Thaw All Layers tool if you want to see things on layers that had previously been frozen.</td>
</tr>
<tr>
<td><img src="image" alt="Layer is frozen in main modelspace and all viewports" /></td>
<td>Layer is frozen in main modelspace and all viewports</td>
<td>This is the best option to use if you wish to manipulate visibility of layers.</td>
</tr>
<tr>
<td><img src="image" alt="Layer is on in main modelspace" /></td>
<td>Layer is on in main modelspace</td>
<td>Use the Thaw All Layers tool if you want to see things on layers that had previously been off.</td>
</tr>
<tr>
<td><img src="image" alt="Layer is off in main modelspace and all viewports" /></td>
<td>Layer is off in main modelspace and all viewports</td>
<td>Similar to frozen but AutoCAD still considers the layer with zoom extents and REGEN commands.</td>
</tr>
<tr>
<td><img src="image" alt="Layer is locked." /></td>
<td>Layer is locked.</td>
<td>Objects on that layer may be seen, but can’t be manipulated.</td>
</tr>
<tr>
<td><img src="image" alt="Layer is unlocked and available for editing." /></td>
<td>Layer is unlocked and available for editing.</td>
<td>Most of your layers will be unlocked while drafting is taking place.</td>
</tr>
<tr>
<td><img src="image" alt="Layer is thawed in current viewport" /></td>
<td>Layer is thawed in current viewport</td>
<td>Every viewport can be different. Use this to your advantage.</td>
</tr>
<tr>
<td><img src="image" alt="Layer is frozen in current viewport" /></td>
<td>Layer is frozen in current viewport</td>
<td>Using the Layer Freeze command inside a viewport will only affect the viewport you are working in – VERY HANDY!</td>
</tr>
<tr>
<td><img src="image" alt="Layer will not plot" /></td>
<td>Layer will not plot</td>
<td>This is a drawing-wide setting for a layer. Frequently used for Viewport layers.</td>
</tr>
</tbody>
</table>
Don’t Freak Out – Use Layer States

When you get into Civil 3D, you’ll see that every element goes to its own layer. This means that a civil 3D project can easily have several hundred layers. To help manage the layers (and your sanity) use **Layer States**.

Let’s say you’ve been working in modelspace freezing things, thawing things, maybe locking things and you think to yourself, “Gee this is a good point I might want to get back to quickly.” Create a new layer state!

Give the new state a name and click OK.

Now you can easily get back to that layer “situation” by hitting the dropdown again and setting your desired state current.

This also works inside viewports! So if you’ve got a pretty state you’d like to plot, double click inside the viewport and set the layer state you want current. More information on viewports is coming up, I promise!

**Other Layer Tidbits:**

- When an object is selected, its layer is displayed in the layer dropdown.
  - To change and object’s layer:
    1. Select the object whose layer you wish to change
    2. Go to the layer dropdown on the Home tab > layers panel
    3. Pick the new layer.

- A really great command to know is the Layer Previous command 
  - . If you want to get back to the layer state you were in last, hit this and it will take you back. For example, say you accidentally hit thaw all layers in a viewport. Layer previous will restore the layers.

- Finished projects should have nothing on layer zero. Lots of objects on 0 indicate a lazy drafter!

- Do not use the Defpoints layer. It doesn’t plot, and is used by AutoCAD as a placeholder for dimensions.
Using Object Snaps

Object Snaps enable you to quickly select exact geometric points on existing entities without having to know the exact coordinates of those points.

Use object snaps to draw more precisely. You can make sure that object truly “touch” or are drawn the way you intended.

The most common object snaps you’ll use are endpoint, midpoint, node and intersection.

If you right-click on the OSNAP icon at the bottom of your screen you’ll see a list of the available snaps that you can have running all the time when you are drafting. Active snaps are highlighted in blue.

The most useful snaps to know for the Civil 3D user are:

<table>
<thead>
<tr>
<th>Snaps</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint</td>
<td>Endpoint grabs the ends or vertices of any type of line or arc.</td>
</tr>
<tr>
<td>Midpoint</td>
<td>Midpoint grabs the “halfway point” between two vertices of any line or arc.</td>
</tr>
<tr>
<td>Node</td>
<td>Node snaps to points. In the case of a Civil 3D survey point, node coincides with the insertion point.</td>
</tr>
<tr>
<td>Intersection</td>
<td>For two objects at the same elevation, intersection picks the point where they cross. (If the objects are at different elevations, use Apparent Intersection)</td>
</tr>
</tbody>
</table>
Other useful tidbits about Object Snaps:

- If you want your object snaps to ignore the elevation of the object you are picking, type `OSNAPZ` at the command line. Set this variable to 1.
- Be patient when using object snaps on Civil 3D objects. Sometimes it takes a moment for the object snaps to sort out all the data you have on your screen. Pause your cursor where you expect the object snap to appear and it will pop up.
- Be aware of your zoom level when running object snaps. OSNAPS work even when the object you are snapping to is off-screen. For example, the closest endpoint of a line may be outside of your screen’s view. When you click, the line you are drawing will jump to that off-screen spot.
- You can turn object snaps on/off on the fly by using the F3 key.

Basic Modify Tools

Once you locate these commands on the Modify Panel, the only learning curve working with the tools is getting used to the order in which you do your clicking and picking.

⭐ Keep an eye on the command line to help steer you in the right direction.

Erase

There are two main ways to erase objects in AutoCAD.

1. The easiest way is to select the objects you wish to remove, and then press the delete key.
2. If you want AutoCAD to prompt you to select Objects: use the erase command from the modify toolbar.
Move

Example Workflow: Move

1. Hit ESC several times to ensure you are out of any other commands. This will also ensure that you do not have any objects selected.
2. Click the Move command. 
3. You are prompted to Select Objects:
4. Use a crossing window to select the objects you wish to move.
5. Right-click to move on to the next step.
6. The command line now reads:
   Specify base point or [Displacement] <Displacement>:
   a. The base point is referring to the location you are moving the objects from.
   b. The second point is where you are moving the objects to.
7. When the second click is complete, the command is finished.

When you finish working with an AutoCAD command, you are taken back to a command line prompt. When you see the word Command: at the prompt you know you are in a selection mode.

If you want to restart a command again right away, right-click and select Repeat

★ If an object (or several objects) are already selected at the time you start the command, it will skip past the option to Select Objects. For example, if I had the suitcase objects selected at the time I clicked Move, it would jump me to step 6.
Copy
Example Workflow: Copy

1. Click the **Copy** command.
2. You are prompted to **Select Objects**:
3. Use a crossing window to select the objects you wish to move.
4. Right-click to move on to the next step.
5. The command line now reads:
   
   ```
   Specify base point or [Displacement] <Displacement>:
   a. The base point is referring to the location you are moving the objects from.
   b. The second point is where the duplicate object will appear.
   ```
6. Your command line now says:
   
   ```
   Specify second point or [Exit/Undo] <Exit>:
   You can keep making copies of your objects.
   ```
7. Hit enter when you are done making copies.

---

Offset
Example Workflow: Offset

1. With no objects selected, click the Offset tool.
2. The command line now reads:
   
   ```
   Specify offset distance or [Through/Erase/Layer] <3.0000>:
   Type in the distance you wish to offset the line or polyline.
   ```
3. The command line now reads:
   
   ```
   Select object to offset or [Exit/Undo] <Exit>:
   Click on the object you wish to offset.
   ```
4. Now your command line says:
   
   ```
   Specify point on side to offset or [Exit/Multiple/Undo] <Exit>:
   ```
5. Click on the side you wish to offset.
   At this point you should see the new object you created.
6. The command remains active until you hit enter.

The offset command adjusts the geometry of the line to get a consistent distance between the original and offset line. This means that arcs will have different radii in the offset object.

You can offset almost every object except 3D polylines using base AutoCAD.
**Rotate**

Example Workflow: Rotate

1. With no objects selected, click the Rotate tool.
2. The command line now asks: **Select Objects:**
3. Select the object or objects you wish to rotate.
4. Right-click when you are done selecting entities to rotate.
5. You are now asked: **Specify base point:** Use object snaps to select the base point.
6. You are now asked to **Specify a rotation angle.** The default options allow you to type in a rotation angle or graphically select the rotation angle. If you type in a rotation angle, hit enter to finish the command.

By default, AutoCAD considers due East = 0°.

When we get into Civil 3D there are more options for specifying angles (such as bearing), so if the angle defaults in AutoCAD bug you, don’t worry!

**Explode**

There are some situations where you want to break apart an AutoCAD object into components that make it up. For example, you may wish to turn a polyline into several line segments. You may wish to turn a block into regular lines. To break down an object into smaller parts explode can be used.

⚠️ Use Explode with caution!

★ Using explode on a Civil 3D object (such as a surface) will remove the information behind it, leaving you with just the graphical representation.
BONUS! Using Polar Tracking

Polar tracking allows you to draw or move an object in a specific direction without using ortho mode or angular key-ins at the command line. When the option is highlighted on the status bar, you will automatically get polar tracking lines at 90° intervals.

If you see the tracking line with your cursor, you can simply type the distance at the command line, then enter. Without polar tracking turned on, you would need to use the tedious notation of \@20<90 to denote a distance of 20’ at 90°.
Block Basics

A block is a group of AutoCAD objects that have been tied together. A block can be used like a rubber stamp – you can have the same items over and over in the same drawing without having to recreate them.

★ Every block has a main base point. The base point appears as a grip when you select the block.

For using Civil 3D, being able to create a block isn’t as necessary as knowing how to utilize ones that have already been created.

Here are the most common ways to work with existing blocks:

- Insert a block from a tool palette
- Insert a block that already exists in the drawing
- Insert a block that comes from an external DWG.
Inserting from a Toolpalette

To open up the toolpalette, click the icon "Open Toolpalette".

When you are using civil 3D, the first set of tools you will see on the tool palette are special roadway creation tools. To access some of the blocks available to you, right-click on the edge of the tool palette.

Select Civil Multiview Blocks.

Once you have switched palette groups, the set of tabs along the side of the palette will change. The tabs represent different groupings of tools.

This tool palette contains blocks that are useful to Civil 3D users. Click on the Landscape tab. Click the Detail tree 01.

The first click places the base point of the block wherever you click in the graphic.

The second click establishes the rotation of the block.

After you are done setting the rotation, you are back at a Command prompt.
Inserting a Block Using the Insert Command

If you don’t have blocks set up on a tool palette, you can use the more traditional **Insert Block** command.

From the Insert tab, go to the block panel and select **Insert**.

At this point you will need to decide where the block information is coming from.
- Existing in the current drawing
- External file

Existing Block

If a block has already been inserted into the drawing or is defined in the template, you can easily insert it using the insert block command.

Go to the **Insert** command.

Click the dropdown to see the blocks available to you.

Select the block you wish to work with.

Set your Insertion point, scale and rotation options.

Click **OK**.

Browsing for Blocks

A block is just a special case of a DWG file. In fact, any DWG file can be used as a block.
When you get to the insert dialog box, click the Browse button and navigate to the folder where the DWG is saved.

Set the insertion, scale and rotation options.

Click OK.

Once the block has been pulled in from an outside file, it is no longer necessary to browse out for it again. It will now show up in the list of blocks available in the drawing.

What About Those Settings?

So, you noticed those checkboxes on the insert block settings.

The **insertion point** refers to where the block base point is going to end up when you place it in your drawing.

The **scale** refers to how large the block will come in; as compared to the size the block was defined. You always want Uniform Scale checked on.

**Rotation** specifies the angle at which the block will come in. This rotation angle is similar to the rotation angle used in the Rotate command.

The block unit is AutoCAD reporting to you if it is doing any unit conversion. For instance, if the block you have browsed for has been created in inches, AutoCAD will show the conversion that is automatically happening.

**Explode** should remain unchecked. You can always explode the block after it has already been inserted.
Paperspace and Modelspace

Working with Paperspace and Modelspace can be a funky concept for people who have never used AutoCAD before.

The tabs on the bottom of the drawing area will switch you between main Modelspace and the layout tabs.

The Model Tab (the “Real” Modelspace)

★ The model tab is where you will do the vast majority of drafting, design and annotation.

You will work in real-life scale; a 24’ wide road will be 24’ wide. Always draw your objects at a 1:1 scale in Modelspace.

The annotation scale you see while you are working in Modelspace affects the size of text placed by Civil 3D or annotative text placed by AutoCAD. While you are in the model tab, this scale is determined by drafter’s preference. Because you will do all your plotting out of paperspace, the scale doesn’t affect anything at all – other than your ability to see it!

Layout – Paperspace

The layout tabs are there for you as you get ready to print your project. Switch to the layout tab you wish to work with by clicking on the name of the tab at the bottom of your drawing screen. Once you have switched to the layout, you will see the following:

★ The layout tabs represent how your page will be arranged when printed*. 
The big white square represents the size and orientation of the piece of paper you would like to squirt out of your printer*.

*We’ll get into how to set the paper size when we talk about printing.

The dashed line represents the **printable bounds**, or the limit as far as how close to the edge of the paper you printer can print. The distance between this dashed line and the edge of paper is usually determined by the printer you are sending your design to.

★ The **viewport** is a window into your design.

The triangular **Paperspace UCS icon** is a sign to us that we are in paperspace. Any drawing we do when the triangular icon is showing will only be on our current layout. We are not affecting Modelspace as long as you see this symbol or the PAPER button at the bottom on the screen.

Any zooming in and out just zooms the paper itself, and does not affect the final print of the drawing.

★ Paperspace is where you will draw your title block, add north arrows and add text related to the date, project location etc.

---

**Layout- Modelspace**

If you double-click inside the viewport you are activating a viewport.

You’ll notice that the UCS icon changes and the viewport outline gets heavier. You are now in Modelspace!

We can now work inside the viewport. Any drawing we do at this point affects the main model.

If we zoom and pan in this state you are changing the scale and location of the Modelspace view.

★ It is a great idea to lock the viewport once you have gotten your view in the right place and at the desired scale. With the viewport active, set the scale by using the scale list in the status bar.

Unlocked

Locked

When the viewport is locked, you can still draw in Modelspace and manipulate layers, you just can’t pan or zoom.

To get back to paperspace, double-click outside the viewport or click the MODE button in your status bar.
Bare-Bones Printing

Printing out of AutoCAD is very closely related to the layout tabs.

★ All formal printing will happen from the layout tabs. The only time you would print from the Model tab is if you are just creating a check – and are not concerned about scale or a titleblock.

By the way, “printing” and “plotting” are interchangeable terms – so don’t get confused if AutoCAD or I switch it up on you.

Getting Ready to Print

In the section about layouts, I told you what you were looking at when it comes to the paper and the printable bounds, but I never told you how to get the papersize you want.

Now I will.

Right-click on the tab you are working with. Select Page Setup Manager…

In the Page Setup Manager, click NEW…
In the **New Page Setup** dialog box you are creating the name for your printing settings.

I recommend having the name reflect:
- The name of the printer
- The paper size
- What type of color the print out will be

Click **OK**.

Ahh… now you are at the nerve center of all things printing!

First, set your printer to the correct device. All printers that you are attached to will show up in this list, as well as some options for printing to a file (such as PDF).

Next, set your paper size. The list of sizes comes from the printer.

The “what to plot” option should always read “Layout”.

Leave the plot offset at X: 0.000 inch, Y: 0.000 inch.

Plot scale should be 1”=1’. Remember we set the viewport to an appropriate scale, so the scaling is taken care of already.

The color table needs to be set to reflect how you want to handle colors from the drawing.
- Want full-color, what-you-see-is-what-you-get in your print? Use ACAD.CTB
• Want some colors to be dark gray, some black, some lighter gray? Use GRAYSCALE.CTB
• Want all black lines? Use MONOCHROME.CTB

Leave the rest of the settings as-is and click **OK**.

Now click **Set Current**.

In the background you will see the paper size change to the size you set in the last step.

You will also see that the name of your page setup appears in parenthesis next to the name of your active Layout.

Yay! It works!!

Close the Page Setup Manager.

The beautiful thing about this is that we can recycle the Page Setup you created. Odds are good that another layout will go to the same plotter, have the page size and same color settings.

Switch to the layout you wish to change.

Right-click on the layout tab and pick **Page Setup Manager**.

Highlight the page setup (HP400 34x22 B&W).

Click **Set Current**.

Cool. You just saved yourself the trouble of redoing those settings for each layout.

**The Print**

We are going to keep this printing thing as simple as possible. In the future, you may want to get acquainted with the Publish option, which allows you to print multiple pages in one shot. In this document, I’m going easy on you. It is near to the end of the document and you are probably tired of reading all this stuff anyway.
Just go to the Application Menu and click **Print**.

(No need to dive into the other options on the right.)

You will see the print settings you created previously.

★ **Always use the Preview button before you print.**

When you click Preview, you will see EXACTLY what will squirt out of your printer. If there is a problem here, you can correct it before you commit it to paper.

If you like what you see, click print. 😊
External References (XREFs)

External references are a way of viewing another drawing as a backdrop for your current drawing. You can measure, snap to and work with layers of the items in the referenced drawing.

There are several reasons why you would want to use XREFs:
- Prevents your current drawing from getting too big.
- Allows other people to work in the XREF’d drawing while you are working in the current drawing.
- Gives you access to some Civil 3D data in the XREF’d drawing.

First, create a new layer for your XREF, for instance, “XREF1”. (Color doesn’t matter)

Set the new layer current.

Before you attach a drawing as an XREF, save your current drawing.

To attach another drawing, go to the Insert tab > Reference panel and click Attach.

★ Make sure your Files of Type is set to DWG. It is possible to attach other types of files, but we’re sticking to the basics in this document.

Use the Overlay option.

Set the Path type to Relative path.

Click OK.

If your current drawing and the XREF drawing are in the same coordinate system, keep the scale, insertion point and rotation at the default values.

If they are not, toggle on the Locate using Geographic Data option.
The XREF layers now appear in the Layer Properties manager and can be frozen & thawed individually just like any other layer.

★ If you want to hide the entire XREF quickly, you can Freeze the “XREF1” layer.

Next Steps

This document covers the bare-bones basics to prevent you from tearing your hair out if you are new to the current release of AutoCAD.

Topics you may also want to understand, but are not critical to working with Civil 3D include:
- Working with text
- Working with dimensions
- Understanding annotation scale